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Paso 1: Crear una cuenta y descargar Mendeley 
 
Entrar para registrarse en http://www.mendeley.com/ 
 

 
Y seguir estas recomendaciones: 
 
Registrarse. Es posible entra con la id y contraseña de Facebook, pero es más recomendable hacer 
un registro independiente.  
Lo primero que se nos pide es nuestro nombre y una dirección de correo electrónico: 
 

 
 
En el registro podemos añadir detalles biográficos profesionales, intereses académicos, 
afiliaciones, intereses, podemos subir nuestro CV, premios, colaboraciones institucionales, etc. El 
perfil mostrará los datos que hemos introducido. Se puede modificar cuando se quiera.  
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En este segundo paso, pinchamos en Download Mendeley, y se nos instala en nuestro ordenador 
el programa Mendeley Desktop, en el que podremos trabajar con nuestras referencias sin utilizar 
un navegador, incluso sin conexión a Internet. 
 
 

 
 
 
Se instala el icono de Mendeley en nuestro escritorio y ya podemos empezar a utilizarlo: 
 

 
 
Siempre podremos entrar a nuestra cuenta desde http://www.mendeley.com/, o por medio de 
Medeley Desktop. 
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Mendeley Desktop (escritorio de nuestro ordenador): 
 

 
 
Mendeley Web (desde cualquier navegador: Mozilla, Chrome, Explorer, etc.): 
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Es muy importante verificar la dirección de email, pues si no se verifica el correo, no se podrá 
sincronizar la versión web con la del escritorio. 
 
Características de la versión web: 
Dashboard 
Una vez que tenemos la cuenta, en la versión web lo primero que vemos es la pestaña Dashboard 
(tablero de mandos): 
 

1. Newsfeed: aparecen novedades de nuestros contactos y grupos, y la posibilidad de escribir 
nosotros preguntas o comentarios que serán vistos por nuestros contactos. 

2. Account settings: para gestionar la cuenta, desconectarse o modificar y/o añadir detalles a 
nuestro perfil 

3. Web Importer : Opción de instalar en la barra de marcadores el botón Web Importer (save 
to Mendeley) para guardar información de páginas web, e importar contenido desde 
distintas fuentes y bases de datos. 

4. Edit profile : posibilidad de completer con datos personales y profesionales nuestro perfil, 
para ganar en visibilidad y entrar en contacto con investigadores y profesionales 
relacionados con nosotros. 

My library  (Mi colección en la versión web) 
 
Se trata de una réplica de nuestra colección de referencias en Mendeley Desktop, lo que nos 
permite acceder desde cualquier ordenador conectado a Internet, y gestionar nuestra colección, 
aunque ese ordenador no tenga instalado el programa. Siempre hay que sincronizar Mendeley 
Desktop para no perder la información actualizada. 
 



 7

Otras opciones: Papers, Groups, People 
 
En estas pestañas podemos buscar publicaciones en el catálogo de Mendeley (con más de 300 
millones de documentos que han ido añadiendo todos los usuarios, que podemos añadir 
directamente a nuestra colección), podemos encontrar grupos de usuarios afines a nosotros, y 
también podemos entrar en contacto con otros usuarios (People). 
 
Características versión local: 
La pantalla en la versión local se estructura de la siguiente manera: 

 
 

1. Contenido estructurado en forma de índice (todo Mendeley, Mi biblioteca organizada en 
carpetas, contenido de los Grupos, etiquetas, etc.) 

2. Visualización de las referencias en formato breve. Dispone de 2 tipos de visualización: 
 
Formato tabla: 

 
 
Formato cita, en el que las referencias aparecen en varias líneas de acuerdo con el estilo de cita 
elegido (en el ejemplo, formato APA): 

 
 

3. Cuando seleccionamos cualquier documento, vemos sus detalles en la parte derecha, y 
también se pueden agregar etiquetas y notas. 

 

Paso 2: Añadir contenido a nuestra biblioteca de referencias 
 

Manualmente 

 
Desde el menú principal pulsamos en “File” y elegimos “Add entry manually” para añadir la 

entrada manualmente. 
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Nos aparecerá un formulario para que introduzcamos los datos del nuevo documento: 
Tipo: artículo de revista (journal article), tesis (thesis), libro (book), capítulo de libro (book 
section), página web (Web page), etc. Mendeley dispone de 20 tipos de documentos distintos, en 
función del tipo de documento elegido los campos a rellenar serán distintos. Además nosotros 
podemos personalizar y añadir otros campos a cada tipo de documento desde “Tools > Options > 
Document details 
 

Al introducir los datos bibliográficos del documento debemos tener en cuenta: 
Autor: la entrada de los autores se hace en la forma Apellidos, Nombre (Last name, First Names) 
Se pueden añadir etiquetas (tags) que identifiquen el contenido del documento para su posterior 
recuperación. Se introducirán separadas por punto y coma. 
Podemos incorporar un pequeño resumen, palabras clave, la URL donde se localice el artículo en 
Internet, un archivo con el texto completo del documento y también identificadores particulares 
del artículo como son el DOI o el PMID. 
 

Importar  resultados desde bases de datos.  

 
Desde Scopus y Science Direct (Elsevier): botón de exportación directa 
 
Para llevar resultados directamente desde una búsqueda en Scopus o en Science Direct a nuestra 
cuenta de Mendeley, tenemos que seleccionar los documentos que queramos exportar.Clicar en el 
enlace Export 
 

 
 
 
Si es la primera vez que exportamos, con nuestra cuenta abierta, tenemos que seleccionar nuestro 
gestor de referencias: Save to Mendeley 
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Si ya tenemos cuenta en Mendeley nos pide que entremos: Sign in 
 

 
 
 
Cuando introducimos usuario y contraseña, nos aparece la selección de documentos lista para 
guardarlos, clicando en Save all. 

 
 
Una vez que hemos elegido nuestra opción, en las siguientes sesiones en Scopus con nuestra 
cuenta aparecerá el botón de exportación directa de Mendeley: 
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Si queremos cambiar esta opción, tenemos que hacerlo desde Settings 
 

 
 
 
Desde otras bases de datos: creación de un archivo RIS o BibTex 
 
Desde otras bases de datos como las de CSIC, Dialnet, Ebscohost (ERIC, MLA, Medline, 
PsycINFO, etc.), ProQuest, Web of Science, JSTOR, etc., el procedimiento es: 
 

1. Seleccionar un conjunto de resultados. 
2. Elegir la forma de exportar o descargar los resultados. 
3. Crear un archivo RIS o BibTeX que se guardará en el ordenador, normalmente en 

Descargas o Downloads 
4. Importar dicho archivo en Mendeley Desktop, File > Import > RIS o BibTeX 

 
Ejemplos: 
CSIC 
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Dialnet: 

 
 
 
Proquest 
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JSTOR 
 

 
 

 
 
Web of Science 
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Importación en Mendeley Desktop: 
 

 
 

Capturar información bibliográfica de la Web. 

 
Otra forma de importar referencias bibliográficas es usando la función Web importer, que nos 
permite importar referencias con un simple click desde portales y proveedores de información 
tales como: ACM Portal, Amazon, Annual Reviews, arXiv, BioMedCentral, CiteULike, EBSCO, 
Google BookSearch, Google Scholar, IEEE Xplore, PLoS, PubMed, RePEC, SpringerLink, 
Wikipedia, Wiley Online Library. WorldCat. También nos permite capturar la información de 
páginas web. Para ello hay que instalar el plugin. Desde el sitio web de Mendeley: 
http://www.mendeley.com/import/ 
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Basta con arrastrar el botón  a la barra de herramientas de nuestro 
navegador.  

 
 

Añadir directamente documentos desde archivos PDF. 

 
Otra opción para incorporar información a nuestra biblioteca es añadiendo los archivos PDFs de 
los artículos. Mendeley recupera automáticamente los metadatos del documento, las palabras 
clave y las referencias citadas en ellos.  
Esto se puede hacer clicando en el botón “Add Files” en la barra de herramientas o arrastrando y 
soltando los PDFs en el panel de contenido. Con “Add Folder” podemos importar de un golpe 
todos los pdf que tengamos guardados en una carpeta determinada.  
 
File > Add Files 
 

 
Buscamos la unidad y carpeta en donde tenemos el archivo y lo agregamos: 
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Arrastrar y soltar archivos en formato pdf: 
 

 
 
 
La información que nos aparece será la que proporcionen los metadatos de los documentos, que a 
menudo son erróneos. Normalmente hay que corregirlos. 
 
Aquellos documentos de los que no se incluyesen todos los datos bibliográficos se añaden a la 
carpeta “Needs Review” para realizar una verificación manual y completarlos. 
Cuando se incorpora un documento, Mendeley revisa su catálogo Web para completar todos los 
datos bibliográficos del documento, además ofrece la posibilidad de buscar las referencias en 
Google Scholar, CrossRef, PubMed y ArXiv.  
 

 
 
 

Importar desde otros gestores bibliográficos como EndNote, Zotero, etc., en 
formato RIS o BibText 

 
Con la opción Add Files también podemos incluir en Mendeley referencias que tengamos en otros 
programas gestores, como RefWorks, EndNote, Zotero, etc. Desde el programa en el que tenemos 
las referencias, exportamos la biblioteca que nos interese en formato RIS o BibTeX, guardando en 
archivo resultante. En Mendeley en “Add Files” seleccionamos el fichero que habíamos exportado 
previamente y pulsamos en “Open”, Se incorporará la biblioteca de nuestro gestor anterior a 
Mendeley. 
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Añadir referencias desde cuentas de otros usuarios de Mendeley 

 
Es posible añadir referencias desde cuentas de otros usuarios de Mendeley, para ello primero 
haremos una búsqueda en la web de Mendeley: http://www.mendeley.com/  sobre el tema de 
nuestro interés: 
 

 
 
Del listado de resultados obtenidos añadimos a nuestra biblioteca aquellos que nos interesen,  
clicando en Save reference o PDF to library. De esta forma guardamos en nuestra colección la 
referencia y el pdf si lo tiene. 
 

 
 

Paso 3: Trabajar con documentos y referencias 
 
Leídos/no Leídos y favoritos 
 

No leídas. Cuando se añaden a Mendeley las referencias aparecen marcadas como no 
leídas con un círculo verde. Una vez que se abren el círculo verde desaparece y quedan marcadas 
como leídas. Podemos marcarlas y desmarcarlas como no leídas tantas veces como deseemos. 

Favoritos. Las referencias y documentos favoritos se marcan con el icono de una estrella a 
la izquierda de la referencia. Se marcan simplemente clicando sobre la estrella para marcarlos 
como favoritos o repitiendo el clic para desmarcarlos. 
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Además todos los marcados como favoritos aparecen en la carpeta “Favorites” del panel 
My Library. 
 
Ordenar las referencias. 
 

Es posible ordenar las referencias desde el panel de contenido, para ello simplemente 
hemos de pinchar sobre la columna que indica el criterio por el que queremos ordenar: favoritos, 
leído/no leído, documentos con pdf adjunto, autor, título, año, revista y fecha de incorporación a 
la base de datos. 
 
Depurar nombres de autor, etiquetas o publicaciones duplicadas. 
 

En el panel de filtro por autor/etiquetas y publicaciones, (Filter by 
authors/tags/publications) seleccionamos el nombre que sepamos que está duplicado o es 
incorrecto, y pulsar y arrastra sobre la forma correcta para renombrarlo. 
 
Buscar 
 

En la versión local, Mendeley contiene un buscador que permite buscar aquellos 
documentos que contengan un determinado término, éste aparecerá destacado tanto en las 
referencias como en todos los documentos que lo contengan. 

Puede buscar en los campos de autor, título, nombre de la publicación, año y notas. 
También se puede realizar la búsqueda dentro del pdf con el texto completo del documento. 
 

Paso 4: Citar referencias y dar formato a un documento 
Con Mendeley, a partir de las referencias recopiladas en nuestra base de datos, podemos incluir 
citas y dar formato a una bibliografía de un documento de una forma muy sencilla. Es compatible 
con los principales editores de texto entre ellos: Word, OpenOffice, Google Docs y LaTex. 
 

Estilos de cita bibliográfica. 

Para seleccionar el estilo de cita que queremos, desde la instalación local de Mendeley debemos: 
Pulsar View > Citation Style del menú principal. Seleccionamos el estilo que necesitamos usar. 
Por defecto Mendeley nos ofrece los estilos más comunes. En caso de que el estilo no esté en el 
listado debemos hacer clic en “More Styles” y buscar el que necesitemos e instalarlo de forma que 
quedará incorporado a nuestra lista 
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Generar Bibliografías, insertar citas y formatear un manuscrito. 

 
Para generar bibliografías, insertar y dar formato a un manuscrito con citas de Mendeley, 

debemos tener instalados los plug-ins disponibles para Word y OpenOffice. Para realizar esta 
instalación debemos seguir los siguientes pasos: 
Desde la opción “Tools” del menú principal debemos seleccionar la instalación que necesitemos: 
Install MS Word Plugin 
Install OpenOffice 
 
Una vez realizada la instalación se incorporará a la barra de herramientas de Word en la opción 
“Referencias” (Microsoft Word Office 2007) 
 

 
 
Mendeley Cite-O-Matic: 
Insert citation : para insertar la cita en el lugar en donde esté el cursor en el texto del documento. 
Styles: desplegable para elegir el estilo de cita. 
Insert Bibliography : para insertar la bibliografía al final del documento. 
 

 
 
Ya podemos trabajar con un manuscrito en Word 



 19

 

Bibliografía 
 
Alonso-Arévalo, Julio. “Mendeley: tutorial de aprendizaje”, 2012, p. 81. 
http://www.slideshare.net/jalonsoarevalo/mendeley-13604013 

Pacheco-Mendoza, Josmel. “Uso de Mendeley 2014”, 2014, p. 87. 
https://www.academia.edu/3579749/Uso_de_Mendeley_2014_ver._1.10.1 

Pacheco-Mendoza, Josmel. “Importación de datos de Web of Science en Mendeley”, 2014, p. 5. 
https://www.academia.edu/5987380/Importacion_de_registros_de_WoS_en_Mendeley 

Rodríguez Otero, Carmen. “Gestor bibliográfico Mendeley: 14 vídeos”, . 
http://www.youtube.com/playlist?list=PLBunRe1ufyHH72vJoxjZfZlXC6745TXZj 

Rodríguez Otero, Carmen. “Guía de uso de mendeley”, 2012, p. 52. 
http://www.slideshare.net/mrodote3/guia-de-uso-de-mendeley 

Rodríguez Otero, Carmen. “Guía de uso del gestor bibliográfico Mendeley”, 2013, p. 51. 
http://www.slideshare.net/mrodote3/presentacin-taller-mendeley-22022013 

The Mendeley Support Team. “Getting Started with Mendeley”. Mendeley Desktop, 2011, pp. 
1–16. http://www.mendeley.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Mendeley paso a paso: sesión básica 2014 por Rosario Guiard Abascal se encuentra bajo una 
Licencia Creative Commons Reconocimiento-NoComercial-CompartirIgual 3.0 Unported. 
 
 
 
Última modificación: 26 de febrero de 2014 


